
▼英語の投稿文　翻訳対比表　2020.8.29作成の最後の文　とその後の返信等の記録
 ▼投稿欄の前書き文と要約文
 MC26　起動時の画面及び途中の画面がおかしい

（私は日本人です。以下の文章はgoogleの翻訳を使用しているので変
なところがあるかもしれません。）
◆投稿文に画像を配置して作る方法がよく分からない。
◆そのため、PDFに変換した添付ファイルを見て下さい。
（これだと、私の意図する形で見れるので）

▼要約のみをここに書きます
★MC26の不思議な表示現象について教えて下さい。

１．MC26のｱｲｺﾝをｸﾘｯｸした直後にﾃﾞｽｸﾄｯﾌﾟの左上端に、小さな画像①の
ように出ます
←これを引き延ばして大きくすると①’の画像になる。
▲しかも、引き延ばして使用してから、ﾌﾟﾚｲﾘｽﾄ状態で、放っておいて
次の曲に移動した途端に、また小さく①になってしまう。
←MC25 のｱｲｺﾝをｸﾘｯｸ直後は画像②が出る
　（MC25は問題が起こらない）

２．不思議現象その２（謎の小画面③出現）
MC26の画面（ﾌﾟﾚｲﾘｽﾄ状態）を、最小化してﾀｽｸﾊﾞｰに降ろした状態にし
てあと、放っておいて次の曲に移動した途端に、今度は③の小さな画面
がﾃﾞｽｸﾄｯﾌﾟの左上あたりに出てくる。

▲これらの現象が不安定のまま出たりする。
▲色々やってみたが直らない。
（詳しくはPDFファイルを見て下さい）
どうか直す方法を教えて下さい。

  MC26 startup screen and intermediate screen are strange 

(I am Japanese. The following text uses google's translation, so it may be 
strange.)

I'm not sure how to place an image in a post.◆
 Therefore, please see the attached file converted to PDF.◆

(Because it can be seen in the way I intended, it is this)

▼Write only the summary here
 Please tell me about the strange display phenomenon of MC26.★

1. Immediately after clicking the icon of MC26, a small image  appears at the ①
upper left corner of the desktop.
←If you stretch and enlarge this, it becomes the image of '.①
▲ Moreover, after extending and using it, in the playlist state, as soon as I left it
and moved to the next song, it became small  again.①
←Image  appears immediately after clicking the MC25 icon②
(MC25 has no problem)

2. Mysterious Phenomenon 2 (Mysterious Small Screen  Appears)③
After minimizing the MC26 screen (playlist state) to the task bar, and then 
leaving it alone and moving to the next song, a small screen  appears in the ③
upper left corner of the desktop. come.

▲These phenomena may appear unstable.
▲ I tried various things but it didn't fix.
(See the PDF file for details)
Please tell me how to fix it. 

  ▼添付するPDFの元

 MC26　起動時の画面及び途中の画面がおかしい

（私は日本人です。以下の文章は google の翻訳を使用しているので変な
ところがあるかもしれません。）

▼　MC26 の不思議な表示現象　について教えて下さい。

　MC26 startup screen and intermediate screen are strange 

(I am Japanese. The following text uses google's translation, so it may be 
strange.)

▼Please tell me about the strange display phenomenon of MC26.
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１．MC26 のｱｲｺﾝをｸﾘｯｸした直後の立ち上がり方がﾃﾞｽｸﾄｯﾌﾟの左上端
に、小さなのが①のように出ますが？
　　　
←①
←これを引き延ばして大きくするしかない。
←①を引き延ばすとこうなる
←以前は最初からこれが出てたのに

　▲しかも、引き延ばして使用してから、ﾌﾟﾚｲﾘｽﾄ状態で、放っておい
て次の曲に移動した途端に、また小さく①になってしまう。
　▼以前（MC25）は、②のように、MC 画面全体がすぐ出て、その後変
な挙動はありませんでしたが？
←②
←MC25 はｱｲｺﾝをｸﾘｯｸ直後にこうなる
←（左に MC26 のアイコンが見える）

◆→私の PC 環境は次の通りです。
　PC は 1 年半前に自作したﾐﾄﾞﾙﾀﾜｰのﾃﾞｽｸﾄｯﾌﾟﾊﾟｿｺﾝで、CPU は AMD の
Ryzen 5 2600 BOX、
　　マザーボードは ASRock X470 Taichi 、グラボは４ K 対応の
RADEON RX 580 8G GDDR5、
　SSD 500GB、HDD ４ TB、モニターは５ K 可で（４ K 使用）iiyama 
ProLite XB2779QQS-S1
　 Windows10 Home ver は 1903

今は MC26 の試用版をゲットしたあと、MC27 の先行予約を完了してい
る状態です　　　　　　　　　　　　　　　　　　　　　　　　　　
　
★PC の問題か、MC26 の問題かを切り分けるために、
　→PC の再起動、ｼｬｯﾄﾀﾞｳﾝ、ｺﾝｾﾝﾄの引き抜き　等をやったが変わら
ず。
　→残してある MC ２５と MC ２４で立ち上げると、①にはならず、快
適に②がすぐに出る。
　　（後述の③の問題も起きない）
　→このことから、この現象は、MC ２６の何らかの問題と思われる。
★どうしたらこの MC26 を安定した状態で②のように出る状態に戻せる
か、皆さん教えて下さい。
　（→なお、後述のリストアで直ったようにみえたが不安定で気まぐ
れ？）

２．不思議現象その２（謎の小画面③出現）

1. The way of standing up immediately after clicking the icon of MC26 appears 
at the upper left corner of the desktop, and the small one appears like .①
：
←①
← There is no choice but to stretch and enlarge this.
← It will be like this if you stretch ①
← Previously this was from the beginning

▲ Moreover, after stretching and using, in the playlist state, as soon as you 
leave it and move to the next song, it will become a small  again.①
▼ In the previous (MC25), like , the whole MC screen came out immediately,②
and after that there was no strange behavior?
←②
← MC25 will be like this immediately after clicking the icon
← (MC26 icon is visible on the left)

→My PC environment is as follows.◆
The PC is a mid-range tower desktop PC that I made one and a half years ago, 
and the CPU is AMD's Ryzen 5 2600 BOX,
Motherboard is ASRock X470 Taichi, Gravo is 4K compatible RADEON RX 
580 8G GDDR5,
SSD 500GB, HDD 4TB, monitor is 5K possible (4K used) iiyama ProLite 
XB2779QQS-S1
Windows 10 Home ver is 1903

Now, after getting the trial version of MC26, the advance reservation of MC27 
is completed.
‥

 In order to distinguish between PC problem and MC26 problem,★
→ I restarted the PC, shut down, pulled out the components, etc., but it did not 
change.
→ If you start up with the remaining MC25 and MC24, it will not be , and  ① ②
will immediately come out comfortably.
(The problem in  below does not occur)③
→ From this, this phenomenon seems to be some problem of MC26.

Please let me know how you can return this MC26 to a stable condition like ★
.②

(→ Incidentally, it seems to have been fixed by the restore described later, but it 
is unstable and capricious?)
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　MC26 の画面（ﾌﾟﾚｲﾘｽﾄ状態）を、最小化してﾀｽｸﾊﾞｰに降ろした状態に
してあと、放っておいて次の曲に移動した途端に、今度は③の小さな画
面がﾃﾞｽｸﾄｯﾌﾟの左上あたりに出てくる。

→タスクバーのｱｲｺﾝをｸﾘｯｸすると③は消えたり出たりする。（中位の大
きさの画面は出ない）
→音は画面が③のままで、次の移動した曲の動画の音が再生されてい
る。
→また③はいつのまにか消えてたりする。そうかと思えば③でなく中位
の大きさの画面が出ることもある。
←③
←次の曲に移動した途端に、これが出る
←これを W ｸﾘｯｸすると、最大化画面になり音と絵は出る
←③の別ﾊﾟﾀｰﾝ
←文字がない　のも、たまに出る
→しかも②のﾌﾟﾚｲﾘｽﾄ状態から、ある曲を選ぶと、最大化画面で始まっ
てしまう。
　　（同じ中位の画面のまま音楽が始まってくれない）

３．私がほかにやってみたことは以下のとおりです。
★ヘルプの「更新版」→最新情報を確認→最新版をｲﾝｽﾄｰﾙ→MC26.0.103 
に更新された。
　　（26.0.98 から　26.0.103 に更新されたが、上の現象は変わらず）
　　　　　　　　　　　　　　　　　　　　　　　　　
　★ｲﾝｽﾄｰﾙｷｰ（.mjr ﾌｧｲﾙ）をｸﾘｯｸ→「ﾗｲｾﾝｽがｲﾝｽﾄｰﾙされました」の小
窓（→上の現象は変わらず）
　
★→再リストア（復元）をやってみたところ（ﾘｽﾄｱは 1個減って残 8個
になった）、
　　→再起動後には、１．の現象は、①でなく中位の大きさ画面の②で
始まるようになったが、
　　一時的にまた①に戻ったり、直ったり？（別な曲を選んでも最大化
画面にはならなくなった）
　→なお、２．の現象は変わらず、③の小さな画面がまた出てくる。

　★このあと、ﾗｲﾌﾞﾗﾘの復元を、問題が出ない MC25 の Library Backups
の最後の時点の Zip ﾌｧｲﾙを選んでやってみた。一時的に①でなく②に
なったが、また①に戻って、結果効果なし。
③の現象も同じ。
（なので、ﾗｲﾌﾞﾗﾘの復元を元の MC26 の最後のに戻して復元した）

　★　（次に MC26 の表示関係の、設定の変更で直るのかもと思っ

2. Mysterious Phenomenon 2 (Mysterious Small Screen  Appears)③
After minimizing the MC26 screen (playlist state) to the task bar, and then 
leaving it alone and moving to the next song, a small screen  appears in the ③
upper left corner of the desktop. come.

→ Click on the icon on the taskbar and  will disappear or come out. (The ③
screen of medium size does not appear)
→ The sound remains on screen  and the sound of the movie of the next ③
moved song is being played.
→ In addition,  disappears without notice. If you think so, a medium-sized ③
screen may appear instead of .③
←③
← This appears as soon as you move to the next song
←If you click this with W, it will be maximized screen and sound and picture 
will appear
← Another pattern of ③
← Even if there is no character, it sometimes appears
→ Moreover, if you select a song from the playlist state of , it will start with ②
the maximized screen.
(Music does not start with the same middle screen)

3. The other things I've done are:
 "Updated version" in Help → Check latest information → Install latest ★

version → Updated to MC26.0.103.
(Updated from 26.0.98 to 26.0.103, but the above phenomenon does not change)

Click the installation key (.mjr file) → The small window of "The license has ★
been installed" (→The above phenomenon does not change)
‥

 → When I tried to restore again (restore decreased by 1 and there are 8 left),★
→ After restarting, 1. The phenomenon of began to start at  of the medium ②
size screen instead of ,①
　Temporarily returning to  or fixing again? (Selecting a different song no ①
longer causes the maximized screen)
→ In addition, 2. The phenomenon of does not change, and the small screen of 

 appears again.③
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て、）
　★ツールのオプションの「スタートアップ」の「モード」を「前回終
了時の画面」にﾁｮﾝしましたが変わらず。
　★同じ「スタートアップ」の「保存場所」？？を「ﾌﾟﾚｲﾘｽﾄ」にﾁｮﾝし
ましたが変わらず。

　★ ツールのオプションの「ツリーと表示」等を見ても、どこが関係
してるのかよく分かりません
　（なお、問題のない MC25 の設定状態をみても同じだった。なのに
MC26 だけが変？？？）

★→なお「windows10 ウィンドウサイズ 記憶されない」の検索で出てく
る「ウインドウのスナップ」をオフやオンを色々やってみましたが、ダ
メでした。

★→以上をやったが、現在は結局ｱｲｺﾝをｸﾘｯｸ時には、①は出なくなって
②で始まる状態になったり、①が出る状態になったりで不安定。
③の状態は相変わらずです。分からない不思議な表示現象のままです
（いちいち操作をすれば目的画面は出せますが、なんとも不便です）
　　
◆なお、過日（8月 8 日）Windows10 のｽﾀｰﾄﾎﾞﾀﾝを見たら、一番上の
「最近追加されたもの」（8月 3 日）に「Media Editor」（C:Program 
Files Jriver MC26 にあり）と「Media Server」（場所不明、ｼｮｰﾄｶｯﾄﾌｧｲ
ﾙ？）がある。
「Media Server」をｸﾘｯｸしたら、画面左上端に③と似たのが出た。
→ﾀｽｸﾊﾞｰを右ｸﾘｯｸすると 3 つ選択肢があり、 の所で閉じたら消えた。✖
→その後 MC26 のｱｲｺﾝをｸﾘｯｸしたら、なんと最後に閉じた MC26 の中位
の画面（曲が並んでいる画面）が出るようになった。（②が出る場合も
ある）
（なお、ﾂｰﾙ→ｵﾌﾟｼｮﾝ→ｽﾀｰﾄｱｯﾌﾟの「ｽﾀｰﾄｱｯﾌﾟ時のｱｸｼｮﾝ」の「□現在の
ﾌﾟﾚｲﾘｽﾄの再生開始」にはﾁｮﾝは入っていないのに？）
→この中位の画面を最小化すると、ﾀｽｸﾊﾞｰにｶｰｿﾙを置いただけで直上に
この画面の小さなのが出るようになった（本来の姿？）→しかし時々③
のようなのになることもある。

→なお、中位の画面をｻｲｽﾞ変更したり表示位置をずらしたアト、次の曲
に移ると元の大きさと位置に戻ってしまう。
→現在は、こんな状態が MC26 の起動時前後の様子です。不安定です。
不思議です。

▲▲このあとは、何をやったらいいのか分からないので、皆さんよろし
くご教示お願いします。

* After this, I tried to restore the library by selecting the Zip file at the end of 
MC25's Library Backups, which does not cause any problems. It became  ②
instead of  temporarily, but returned to  again and there was no effect.① ①
The phenomenon of  is the same.③
(So I restored the library back to the last MC26)

 (Next, I wonder if it might be fixed by changing the settings related to the ★
MC26 display.)
* The "Mode" of "Startup" of the tool option was changed to "The screen at the 
time of the previous end", but it did not change.
* Same "startup" "save location"? ? I chose "Playlist" but it didn't change.

I don't know what is related even if I look at the options such as "tree and ★
display" of the tool.
(It was the same when looking at the setting state of the MC25, which has no 
problem. However, only the MC26 is strange????)

 → I tried turning off and on "window snap" that appears in the search for ★
"windows10 window size is not remembered", but it didn't work.

→ I did the above, but now when I click the icon, it is unstable because  ★ ①
does not come out and begins with , and  comes out.② ①
The state of  is still the same. It remains a strange display phenomenon that I ③
do not understand
(The target screen can be displayed by doing each operation, but it is 
inconvenient)
――

If you look at the Start button of Windows 10 on the past day (August 8th), ◆
you can find "Media Editor" (C:Program Files Jriver MC26) at the top 
"Recently added" (August 3rd). ) And "Media Server" (location unknown, short 
cut file?).
When I clicked "Media Server", something similar to  appeared in the upper ③
left corner of the screen.
→When you click the task bar to the right, you have three choices. It 
disappeared when you closed it at .✖
→ After that, when I clicked on the MC26 icon, the last closed MC26 middle 
level screen (screen with songs lined up) came out. (  may appear)②
(It should be noted that there is no option in "Start playback of current playlist" 
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　　　（上記の私の解釈がおかしいところがあれば、それも教えて下さ
い）
　とりあえず以上、不思議な表示現象です。
→2，3 か月後の MC27 にｱｯﾌﾟした時に直ってくれればいいが、MC26 の
設定がそのまま引き継がれて
反映されると同じかも知れないので、今のうちに直したいです。

どうか直す方法を教えて下さい。

in "Tools -> Options -> Start-up "Action at start-up"?)
→If you minimize this middle screen, you can put a cursor on the taskbar and 
you can see a small part of this screen just above it (original figure?)→However,
sometimes it becomes like .③

→In addition, after changing the size of the middle screen or shifting the display
position, when moving to the next song, it will return to the original size and 
position.
→ Currently, this is the state before and after the MC26 starts up. It's unstable. 
It's strange.

▲ ▲ After this, I don't know what to do, so I would like to ask everyone for 
your support.
(If there is something wrong with my interpretation above, please let me know 
as well)
For the time being, this is a strange display phenomenon.
→ It would be nice if it could be fixed when I updated the MC27 a couple of 
months later, but the settings of the MC26 were taken over as is.
It may be the same as it is reflected, so I want to fix it now.

Please tell me how to fix it. 

 
 ▼８月３０日６時３９分に、INTERACT FORUM チーム。よりメールが来た。（□notise mail ?にチョンしておいたから？）
 
差出人： INTERACT FORUM <mediacenter@jriver.com>　６時３９分
件名：Topic reply: MC26 startup screen and intermediate screen 
are strange

BigSpiderが見ているトピックに返信が投稿されました。

https://yabb.jriver.com/interact/index.php?topic=126683.new;topi
cseen#newで返信を表示します

このリンクを使用して、このトピックの購読を解除します。https：//y
abb.jriver.com/interact/index.php？action = notify; topic = 1266
83.0

より多くの返信が投稿される可能性がありますが、トピックを読むま

 A reply has been posted to a topic you are watching by BigSpider.

View the reply at: https://yabb.jriver.com/interact/index.php?
topic=126683.new;topicseen#new

Unsubscribe to this topic by using this link: 
https://yabb.jriver.com/interact/index.php?
action=notify;topic=126683.0

More replies may be posted, but you won't receive any more 
notifications until you read the topic.

Regards,
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で、通知は届きません。

よろしく、
INTERACT FORUMチーム。 

The INTERACT FORUM Team.

                                                                                             

 ▼その後のリプライと私の返信　BigSpider  さんの投稿　2020 年 8月 30 日６時３９分　

BigSpider　Galactic Citizen  Posts: 305 
  « Reply #1 on: Today at 04:39:04 pm »

Have you got the view set to mini view?
ビューをミニビューに設定しましたか？

Byū o minibyū ni settei shimashita ka?

 
私の返信                                                        
 有難う　BigSpider さん
ミニビューにはしていません。
ミニビューも可能ですが、明らかに違う表示です。
標準の表示中の出来事です。
解決方法をお願いします。

 English spiders are kind of small, but when I was living in the African rain 
forest well ...... 
 イングリッシュスパイダーはちょっと小さいですが、アフリカの熱帯雨林によく
住んでいた時は…… 
  

 Thank you Big Spider
I haven't made a mini view.
A mini view is possible, but it's a different display.
This is a standard display event.
Please give me a solution. 

 ▼tij さんのリプライと私の返信　2020 年 8月 30 日 15 時 5 分                                                                            
 

 tij　MC Beta Team 　Citizen of the Universe 　  Posts: 1054 
« Reply #3 on: Today at 01:05:45 am »

 Seems similar problem to 
https://redmondmag.com/articles/2019/05/14/windows-10-shrinking-
application.aspx

The MC Windows is not just minimize but it is also clipped.

I would suggest (do one at a time ... no need to do all if one works)

1. set DPI (Windows Display Property -> Scale and Layout -> Change the size 
of text, apps, and other items) to 100% ... if you have 2 monitors - set to 100% 
on both

 ▼https：//redmondmag.com/articles/2019/05/14/windows-10-shrinking-a
pplication.aspx と同様の問題のようです

MC Windows は最小化されるだけでなく、クリップされます。

私はお勧めします（一度に 1 つずつ実行します...機能する場合はすべて実
行する必要はありません）。

1. DPI（Windows 表示プロパティ->スケールとレイアウト->テキスト、アプ
リ、その他のアイテムのサイズを変更）を 100％に設定します... 2 台のモニ
ターがある場合-両方で 100％に設定します
2.ディスプレイドライバーを更新する
3. MC26 を再インストールします

　　　　　　　　　　　　　　　　　　　　　　　　　　6

https://redmondmag.com/articles/2019/05/14/windows-10-shrinking-application.aspx
https://redmondmag.com/articles/2019/05/14/windows-10-shrinking-application.aspx
https://yabb.jriver.com/interact/index.php?PHPSESSID=a98slokaer9oma0h939h9b3dp5&action=profile;u=317107
https://yabb.jriver.com/interact/index.php?action=profile;u=325170
https://yabb.jriver.com/interact/index.php?action=profile;u=325170


2. update display drivers
3. reinstall MC26
4. update your Windows to latest 
 
 My reply
Thank you tij
1. The display setting is 100% originally.
(4K setting is "3840 x 2160")
2. I updated the display driver to the latest, but it didn't work.
3. I tried restoring MC26 again, but it didn't work.
4. I uninstalled MC26 and reinstalled it, but it didn't work.
→The screens of , , and  will appear. It appears unstable.① ② ③

▲ If you move the MC25 in the same environment, no problem will occur. It's 
comfortable.
→ This seems to be a problem in MC26. ? ? ?

Please give me a solution◆
Please check the attached PDF file again. There are details about my PC ◆

environment and what I did. 

4. Windows を最新に更新します
記録
HTPC：Win10：v1909（18363.657）、MC：v26.0 

 私の返信（８月３１日１８時１９分に POST した）
有難う tij さん                                                    
１．ディスプレイの設定は、元々 100%です。
　（４ K の設定で「3840×2160」です）
２．ディスプレイドライバーを最新に更新しましたがだめでした。
３．MC ２６のリストアをもう一度やってみましたがだめでした。
４．MC ２６をアンインストールしてから再インストールしましたが、
だめでした。
　→①、②、③の画面が出ます。不安定に出ます。

▲同じ環境で MC25 を動かすと、問題は起こりません。快適です。    
→これは、MC ２６の中の問題だと思われる。？？？
                                                                
◆どうか、誰か解決策を教えて下さい
◆なお、添付の PDF ファイルをもう一度見て下さい。私の PC 環境及び
やったことの詳細があります。

                                                                                                                 
                                                                

▼tij さんの２回目のリプライと私の返信　2020 年９月１日 1３時 5０分                                                                   

 « Reply #6 on: Today at 10:23:49 am »
I notice in your screenshot you have MC shortcut. Are you starting MC26 from 
shortcut?

In that case... right click on shortcut choose

[Properties]->[Shortcut] ... there under [Run] choose "Maximized" or "Normal 
window" ... do not choose "Minimized"
 
私の返信
Thank you tij

 tij さんのリプライ
«返信＃6：今日の午前 10:23:49 に»
スクリーンショットに MCショートカットがあることに気づきました。
MC26 をショートカットから起動していますか？

その場合...ショートカットを右クリックして選択します

[Properties]-> [Shortcut] ... [Run]の下にある「Maximized」または「Normal 
window」を選択します...「Minimized」を選択しないでください 
 
 私の返信（９月１日１３時５０分に POST した）
 有難う tij さん
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It didn't work even if I changed the size of the shortcut of MC26 shortcut 
property at the time of execution.

No matter whether you choose normal, maximized or minimized, the result will 
only appear the same small screen of .①

 After this, I want to try a complete uninstall of MC26.◆
But I'm worried about what will happen.
If you know that this method is dangerous, please tell me what it means.

▲ At the beginning of uninstalling MC26, you have two choices. (→ according 
to the attached file screen (Japanese))
One is to delete the registry.
The other is to delete the library files as well.
I tried the first one, but it didn't work.
→ Is it okay to just make a backup of the library?

Please tell me the difference between the two and the precautions to take ★
when executing. 

MC ２６ショートカットのプロパティーのショートカットの実行時の大
きさを変えて設定してもだめでした。

通常と最大化と最小化のどれを選んでも、結果は①の小さな同じ画面が
出現するだけです。

◆この後に、MC26 の完全アンインストールを試そうと思っています。
でも、どうなるのか心配です。
もし、この方法は危ないと知っていたらその意味を教えてください。

▲MC26 のアンインストールの初めに、二つの選択肢が出ます。（→添
付ファイルの画面のとおり（日本語））
一つはレジストリーを削除する。
もう一つは、ライブラリのファイルも削除する。
一つ目は既に試しましたがだめでした。
→ライブラリーのバックアップを取っておくだけで大丈夫ですか。

★二つの違いと実行する場合の注意することを教えて下さい。

                                                                                                                                   
▼tij さんの３回目のリプライと私の返信　2020 年９月１日２２時４６分

 « Reply #8 on: Today at 05:15:21 am » 
 Can you try starting MC26 from C:\Program Files\J River\Media Center 26 
 
 ▼ Thank you tij
I tried to click Media Center 26.exe directly from C:\Program Files\J River\
Media Center 26.
→ As a result, the same small screen of  appears.①

★I made this a shortcut and clicked from there, but it was the same.
→ The result is that the same small screen of  appears.①
(↓ The attached image of  appears)①

 If you have any other things to try, please let us know.★  

 ◆MC26 を C：\ Program Files \ J River \ Media Center 26 から起動し
てみてください。 

私の返信（９月１日２２時４６分に POST した）
 ▼ 有難う tij さん
 Media Center 26.exe を C：\ Program Files \ J River \ Media Center 26 から
直接クリックしてみました。

→結果は①の小さな同じ画面が出現するだけです。
★これをショートカットにして、そこからクリックしましたが、同じで
した。
→結果はあの①の小さな同じ画面が出現するだけです。
（↓下の添付した①の画像が出現します）

★何か他に試す事項がありましたら、教えて下さい。
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 ▼JimH さんよりのリプライと私の返信　2020 年９月１日２２時５０分

 JimH さんより« Reply #9 on: Today at 07:31:25 am »

Don't change anything in the OS (shortcut picture above).

Change your font size to something smaller.  Try another language, just to see 
whether the problem changes.

Uninstalling probably won't help.  Back up your library first if you do try it.

Re-installing is OK.

Strange problems often have strange causes.  A video driver, for example.  Other
programs affecting display.  This problem is very strange.

Don't try Mini View until Standard View is working correctly.

 My reply (POST at 22:20 on September 1)
▼ Thank you Jim H
→It is very encouraging for me to see this by Jim H.

▼ What I tried
1. I tried reducing the font size.
→ Display → Size → 50%. The result was the same  appearance.①
→ 100% and 70% were the same results.

2. I tried different languages.
→ I changed to English. The result was the appearance of the same small screen 

.①
→ I changed it to German. The result was the same  appearance.①

 Please let us know if you have any other things to try.★

Complete uninstall will be stopped.★
 After this, change the monitor to another old monitor and try. ★

 JimH さんより«返信＃9 on：今日 07:31:25 am»

OS の何も変更しないでください（上のショートカット画像）。

フォントサイズを小さい値に変更します。 別の言語を試して、問題が変化
するかどうかを確認してください。

アンインストールはおそらく役に立たないでしょう。 使用する場合は、最初
にライブラリをバックアップしてください。

再インストールは OK です。

奇妙な問題はしばしば奇妙な原因を持っています。 たとえば、ビデオドラ
イバー。 表示に影響を与える他のプログラム。 この問題は非常に奇妙で
す。

標準ビューが正しく機能するまで、ミニビューを試さないでください。 
  
私の返信（９月１日２２時５０分に POST した）
  ▼ 有難う JimH さん
→JimH さんがこれを見てくれることは私にとって大変心強いです。

  ▼試したこと
１．フォントサイズを小さくしてみた。
　→表示→サイズ→５０％。結果は同じ①出現でした。
　→１００％でも７０％でも同じ結果でした。

２．言語を別のものにしてみた。
　→英語にした。結果は同じ小画面①出現でした。
　→ドイツ語にした。結果は同じ①出現でした。

 ★他に試すことがあれば教えて下さい。

★完全アンインストールは止めます。
★この後、モニターを別の古いモニターに変えて試してみます。
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 ▼JimH さんよりの 2回目のリプライと私の返信　2020 年９月３日１８時００分                                                           

 « Reply #12 on: September 01, 2020, 10:51:57 am » 
 The font size is a different setting.  It's in Options > Tree & View.
Try other skins.  

 
 My reply (POST at 20:35 on September 3)
▼ Thank you Jim H
1. Changing the font size in Options> Trees and Views didn't work either.
2. It didn't work even if I changed to another skin.
3. It was the same even if I changed the monitor to another old monitor.
4. Change the size of characters in Windows 10 and change the overall size. It 
was the same even if I did this.

5. There is one mysterious thing.
→ When you move to the next song after changing the screen position and size 
while playing a playlist, the screen will return to its original position and size. ..
→ However, if a file with only sound and a file with video are mixed, if the next
song is a file with only sound, the song will start without returning to the screen.

→I will explain with the example of the attached file below.
It does not return when moving from  to . (No change)① ②
When moving from  to , the screen returns to the original position and size.② ③
→ It does not change when moving from sound only to sound only.

From this, it can be seen that a strange phenomenon occurs only when ★
moving to the next video.
→ What does this mean?

Please tell me what to try next.◆

 I'm thinking of doing a Windows 10 system restore.◆
→ The restore point is one and a half months before the trial version of MC26 

JimH さんより«返信＃12：2020 年 9月 1 日 10:51:57 am» 
フォントサイズは別の設定です。 [オプション]> [ツリーとビュー]にあ
ります。

他のスキンを試してください。 

 私の返信（９月３日２０時３５分に POST した）
  ▼ 有難う JimH さん
１．[オプション]> [ツリーとビュー]でフォントサイズを変更してもダメ
でした。
２．他のスキンに変えてもダメでした。
３．モニターを別の古いモニターに変えても同じでした。
４．Windows10 の簡単操作の文字の大きさを変える及び全体の大きさを
変える。これをやっても同じでした。

５．一つ不思議なことがあります。
→プレイリスト演奏中に画面の位置と大きさを変化させたあとに、次の
曲に移ると、画面が元の位置と大きさに戻ってしまう現象になっていま
す。。
→しかし、音だけのファイルと動画のファイルが混在している場合、次
の曲が音だけのファイルの時は、画面が戻らないでそのまま曲が始まり
ます。

→下の添付ファイルの例で説明します。
  ①から②へ移る場合は戻りません。（変化しません）
②から③へ移る場合は画面が元の位置と大きさに戻ります。
  →音だけから音だけへ移る場合も変化しません。

★このことから、次の動画に移る場合だけが不思議な現象が起こること
が分かります。
→これは何を意味するのですか？

◆次は何を試したらいいか教えて下さい。                          

◆このアト、Windows10 のシステムの復元をやろうと思っています。
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was installed.
→Please tell me if there are any notes.

★ However, I think that if I do this, it will only repeat itself.
In order to investigate the cause, I think it's better to keep trying as it is.★
For that, I need your next advice.★

 What I don't know most is that the MC25 works well in the same ★★
environment.
→ What does this mean?
→ Is there a problem only with MC26?

 Is there the same phenomenon with other people?★

▲Please give me some wisdom.
→ For example, items such as display options in the MC26 and other programs 
that affect the display

▲That's all for now. 

→MC26 の試用版をインストールする前の、復元ポイントは 1 か月半前
です。
→注意点があれば教えて下さい。
★しかし、私がこれをやっても同じことの繰り返しにしかならないと思
います。
★原因を究明するためには、このままで、何か試しを続ける方がいいと
思います。
★そのためには、私に皆さんの次の助言が必要です。

★★何よりも分からないのは、MC25 が同じ環境で問題なく動くという
ことです。
→これは何を意味するのですか？
→MC26 だけに問題があるのですか？

★他の人で、同じ現象はないのですか？

▲どうか私にお知恵を出して下さい。
→例えば、MC26内の表示オプションと表示に影響を与える他のプログ

ラムなどの項目

▲とりあえず以上です。
      

 

 ①　②　③
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 ▼JimH さんよりの３回目のリプライと私の返信　2020 年９月３日２２時３０分

 JimH« Reply #14 on: Today at 06:53:47 am »

This isn't a problem we're seeing commonly.  It may be something unusual about
your display.  Bad video driver is always a possibility.  Older ones may 
sometimes be better.

Are you using any other software that affects video display?

 JimH«返信＃14 on：本日 06:53:47 am»

これは、私たちがよく目にする問題ではありません。 ディスプレイに異常が
ある可能性があります。 悪いビデオドライバは常に可能性があります。 古
いものの方が良い場合があります。

ビデオ表示に影響を与える他のソフトウェアを使用していますか？ 
  
▼返信は下に一緒にした▼

                                                                                                                                   
                                                                                                                                   
 ▼tij さんの４回目のリプライと私の返信　2020 年９月３日２２時３６分

 ▼tij« Reply #15 on: Today at 07:41:24 am »
I am running out of ideas ... really strange behavior especially considering 
MC25 is working properly

Can you describe your system... Windows full version ... GPU make and 
model ... GPU driver  version ... which antivirus you using
  
  My reply (POST at 24:25 on September 3)
▼ Thank you Jim H and tij

→My PC environment is as follows.◆
1. Windows10 Home ver is 1903
2. The graphic board is RADEON RX 580 8G GDDR5,
→ To be exact, "SAPPHIRE-NITRO+
RADEON RX 580 8G GDDR5 OC
SA-RX580-8GD5N+001V2/11265-01-20G''

▲ Incidentally, this graphic board has a history of being replaced with a new 
one after the first purchased product had a problem after 10 months.
→ The symptom at that time was that a "sandstorm" appeared 4 times at startup,
and a strange noise was heard.
I sent this out for inspection and a new one was sent.

3. The GPU driver version is

 ▼tij«返信＃15 on：本日 07:41:24 am»
アイデアが足りない...特に MC25 が正しく機能していることを考えると、本
当に奇妙な動作

システムについて教えてください... Windows フルバージョン... GPU の製造
元とモデル... GPU ドライバーのバージョン...使用しているウイルス対策 

 私の返信（９月３日２４時２５分に POST した）
  ▼ 有難う JimH さん及び tij さん
 ◆→私の PC 環境は次の通りです。
１．Windows10 Home ver は 1903
２．グラフィックボードは、RADEON RX 580 8G GDDR5、
 →正確には「SAPPHIRE-NITRO+ 
RADEON RX 580 8G GDDR5 OC 
SA-RX580-8GD5N+001V2/11265-01-20G」
 
 ▲なお、このグラフィックボードは、最初の購入モノが 10 か月目に不
具合が発生し、新品に交換した経緯があります。
→その時の症状は、起動時に「砂嵐」が 4回も出て、バチバチと異音が
するようになった。
これを点検に出したら、新品が送られてきた。

３． GPU ドライバーのバージョンは、
①最新のは「win10-radeon-software-adrenalin-2020-edition-20.4.2-
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 The latest is "win10-radeon-software-adrenalin-2020-edition-20.4.2-①
may25.exe"

 The old one is "Win10-64Bit-Radeon-Software-Adrenalin-Edition-18.3.4-②
March23" (the one on the attached DVD)

▲ The environment was old  until recently. (But this is still a strange ②
phenomenon)
→ I changed this to the latest one of , but it did not improve. Currently this ①
state.

In case of old monitor, if it is a new , etc., the "Sandstorm" screen will ★ ②
appear when the PC is started, so it was set to the old . (Old monitor is ②
"HYNDAI-W240D")
→ Even if the new monitor is the latest , the "Duststorm" screen does not ①
appear when the PC starts.
(The new monitor is "iiyama ProLite XB2779QQS-S1" (5K compatible)).

4. The antivirus I'm using is
"Kaspersky Internet Security"

5. The PC is a mid-range tower desktop PC that I made one and a half years ago,
and the CPU is "AMD Ryzen 5 2600 BOX",
The motherboard is "ASRock X470 Taichi",
SSD 500GB, HDD 4TB,

that's all. Please tell me what you understand.
Thank you always. 

may25.exe」
②古いのは「Win10-64Bit-Radeon-Software-Adrenalin-Edition-18.3.4-
March23」（付属の DVD にあるもの）
  
▲環境は最近まで古い②だった。（しかしこれでも不思議な現象は起き
ていた）
  →これを①の最新のものに変えたが、改善しなかった。現在この状
態。

★なお、古いモニターの場合は新しい②等だと、PC 起動時に「砂嵐」
画面が出るので、古い②にしていた。（古いモニターは「HYNDAI-
W240D」）
 →新しいモニターは最新の①でも PC 起動時に「砂嵐」画面は出ない。
　（新しいモニターは、「iiyama ProLite XB2779QQS-S1」（５ K 対
応））。

４．使用しているウイルス対策は、
「カスペルスキーインターネットセキュリティ」

５．PC は 1 年半前に自作したﾐﾄﾞﾙﾀﾜｰのﾃﾞｽｸﾄｯﾌﾟﾊﾟｿｺﾝで、CPU は
「AMD　Ryzen 5 2600 BOX」、
　　マザーボードは「ASRock X470 Taichi 」、
　SSD 500GB、HDD ４ TB、

以上です。分かったことを教えて下さい。
いつも有難う。
                                                                

                                                                

      

 ▼JimH さんよりの 4回目のリプライと私の返信　2020 年９月４日１７時３０分

 « Reply #17 on: Yesterday at 10:54:41 am » 
 Uninstall Kaspersky.  Not disable.  Uninstall.

Sometimes manufacturers install their own software in addition to the drivers.  
You only need the drivers.  Anything that can control the display could cause 
problems.

 JimH«返信＃17 on：本日 10:54:41 am»
カスペルスキーをアンインストールします。無効にしません。アンインス
トール。

メーカーは、ドライバに加えて独自のソフトウェアをインストールする場合
があります。あなただけのドライバーが必要です。表示を制御できるもの
は問題を引き起こす可能性があります。 
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私の返信は３つに対してまとめて以下に

 ▼tij さんの５回目のリプライと私の返信　2020 年９月４日１７時３６分

 ▼tij« Reply #18 on: Today at 12:36:09 pm »
Antivirus do interfere with MC. You need to set up exceptions in AV to not 
interfere with MC.

New major version of MC require you to set up AV for it. Whatever you did in 
Kaspersky to make MC25 work, you need to do for MC26.

Each Antivirus setup is different. Unfortunately I cannot help you with 
Kaspersky as i am running Bitdefender.

My advice ... look into each Kaspersky setting carefully ... and if you see some 
settings for MC25 ... do exact same settings for MC26.

if that fails ... try to uninstall Kaspersky as JimH suggested (you will need to 
configure Windows Defender as it will take over AV functions ... see this https://
yabb.jriver.com/interact/index.php/topic,114101.0.html by Awesome Monkey on
how to set up Windows Defender)

  ▼tij«返信＃18 on：本日 12:36:09 pm»
アンチウイルスは MC を妨害します。 MC に干渉しないように、AVで例外
を設定する必要があります。

MC の新しいメジャーバージョンでは、AVをセットアップする必要がありま
す。 MC25 を機能させるためにカスペルスキーで行ったことは何でも、M
C26 のために行う必要があります。

アンチウイルスの設定はそれぞれ異なります。残念ながら、Bitdefender を
実行しているため、Kasperskyのサポートはできません。

私のアドバイス... Kasperskyの各設定を注意深く調べてください。MC25 の
設定がいくつかある場合は、MC26 にもまったく同じ設定をしてください。

それが失敗した場合... JimH が提案したように Kasperskyをアンインストー
ルしてみてください（AV機能を引き継ぐため、Windows Defender を構成
する必要があります...これを参照してください https://yabb.jriver.com/intera
ct/index.php/topic 、Windows Defender のセットアップ方法に関する Awes
ome Monkeyによる 114101.0.html） 

私の返信は３つに対してまとめて以下に
                                                                                                                                   

 ▼JimH さんよりの 4回目のリプライと私の返信　2020 年９月４日１７時３８分

   ▼JimH« Reply #19 on: Yesterday at 02:29:47 pm »
Uninstall first to see if Kaspersky is the problem.

In fact, using Windows Defender only is a better solution.  

 
 My reply (posted at 18:40 on September 4th) vs. 3 in total▼
▼ Thank you Jim H and tij
(Since I don't understand English well, I am writing with google translation. 

  ▼JimH«返信＃19 on：昨日 02:29:47 pm»
最初にアンインストールして、Kasperskyに問題があるかどうかを確認しま
す。

実際、Windows Defender のみを使用する方が優れたソリューションです。

 
 私の返信（９月４日１８時４０分に POST した）対３つまとめて▼
  ▼ 有難う JimH さん及び tijさん
　　（英語がよく分からないので、google翻訳で作文しています。返信が
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Sorry for the late reply.)

1. I checked the contents of Kaspersky and saw it.
→ In "Application Management", MC24, MC25, and MC26 were all 
"permitted" (trusted) for JRiver startup and restrictions.
→ Kaspersky did not disturb the MC. I think.
(See attached image  below)①

2. As a precaution, I uninstalled Kaspersky Lab.
→ I moved MC26 without Kaspersky, but it was the same as before.
→ The strange appearance of the screen was the same regardless of the presence
or absence of Kaspersky.
(So I reinstalled Kaspersky)

3. Windows Defender was disabled.
→ Windows button → Windows security → Application and browser control →
Provider management → According to the screen shown in.
(See attached images  and  below)② ③

4. I'm not sure,
I saw "https://yabb.jriver.com/interact/index.php/topic,114101.0.html", but I'm 
not sure.
→ "Windows Defender can and does interfere with JRiver Media Center's 
ability to playback all your media files." → (It says so.)

 If Windows Defender is disabled, that's fine.★
→If you don't have Windows Defender, isn't the MC26 in the way?
→Isn't it all right to have Kaspersky alone?

▲ So far, I was able to confirm.
→ If I am misunderstood, please let me know.

 Please give me a suggestion for what to do next.★
Thank you always. 

          
        

遅くなってすみません。）

 １．カスペルスキーの中身を調べて見た。
→「アプリケーションの管理」では、JRiver の起動と制限は,MC24,MC25,
MC26 が全部「許可」（信頼済み）となっていた。
→カスペルスキーは MC を邪魔をしていなかった。と思う。
 （下の添付画像①のとおり）

２．念のため、カスペルスキーをアンインストールした。
→カスペルスキーがない状態で、MC26 を動かしたが、前と同じだった。
→奇妙な画面の出現等はカスペルスキーの有無には関係なく、同じだっ
た。
 （なので、カスペルスキーを再インストールした）

３．Windows Defender は無効になっていた。
→Windowsボタン→Windowsセキュリティ→アプリケーションとブラウザコ
ントロール→プロバイダーの管理→　で出た画面による。
　（下の添付画像②と③を見て）

４．よく分からないのですが、
 「https://yabb.jriver.com/interact/index.php/topic,114101.0.html 」を見
たが良く分からない。
→「Windows Defender can and does interfere with JRiver Media Center's a
bility to playback all your media files.」→ （そう書いてある。）

★Windows Defender が無効になっていれば、それでいいのではないか。
→Windows Defender がない方が、MC26 を邪魔しない状態である？
→カスペルスキーだけあればいいのではないか？
  
▲ここまでは、確認できました。
→もしも私が勘違いしていれば、教えて下さい。

★次にやるべきことのサジェスチョンを下さい。
いつも有難う。
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 ▼JimH さんよりの５回目のリプライと私の返信　2020 年９月４日２２時３分

JimH« Reply #21 on: Today at 07:43:17 am »

I would recommend using only Windows Defender and configuring it.

But what you've learned probably means that the more likely cause is the video 
hardware and driver.  You said you installed what came on the disc, but 
sometimes that can cause problems.  You could try removing that and installing 
only the video driver.  Search for it online and download it from the 
manufacturer.  When you install, read carefully and install only the driver.

 JimH«返信＃21 on：本日 07:43:17 am»

Windows Defender のみを使用して構成することをお勧めします。

しかし、あなたが学んだことはおそらく、より可能性の高い原因がビデオ
ハードウェアとドライバーであることを意味します。 ディスクに付属している
ものをインストールしたとのことですが、問題が発生する場合があります。 
それを削除して、ビデオドライバーのみをインストールしてみてください。 
オンラインで検索して、製造元からダウンロードしてください。 インストー
ルするときは、よく読んでドライバのみをインストールしてください。 
 
私の返信（９月４日２２時４０分に POST した）▼
  ▼ 有難う JimH さん                                                                                           
  １．最新のドライバーの中をいじってみたら、

▼ B4Unyu　さんからの初めてのリプライと私の返信　2020 年９月５日１１時５３分

 « Reply #22 on: Today at 09:04:14 am » 
 korewa tabun MC ni kankenaku Windows ka radeon doriba no shiwazadesuyo.

things you can still try:
- use only Windows Defender (configured for mc)
- remove driver software 20.4.2 and install driver 20.8.3 date 20.08.27 = https://
www.amd.com/en/support/graphics/radeon-500-series/radeon-rx-500-series/
radeon-rx-580 

- check for conflicts and/or try different Windows scaling (settings Display) and 
Radeon Adrenalin scaling

- try windows file explore folder option: view>option>folder options>view> 
restore previous folder windows at login = off (after expanding mc26 window)

- change high dpi scaling for Media Center 26 exe/shortcut >file 
properties>Compatibility>Change high DPI settings  (after expanding mc26 
window)
* combinations of above

 «返信＃22 on：本日 09:04:14 am»
これはたぶん MC にかんなくなく Windows かららでんどりばのしわざです
よ。

あなたがまだ試すことができるもの：
-Windows Defender のみを使用（mc 用に構成）
-ドライバーソフトウェア 20.4.2 を削除し、ドライバー 20.8.3 をインストール
します。日付 20.08.27 = https://www.amd.com/en/support/graphics/radeo
n-500-series/radeon-rx-500-series/radeon- rx-580

-競合を確認し、Windows の別のスケーリング（ディスプレイの設定）と R
adeon Adrenalin のスケーリングを試します。

-Windows ファイル→エクスプローラーフォルダーオプションを試してくださ
い：ビュー>オプション>フォルダーオプション>ビュー>ログイン時に以前
のフォルダーウィンドウを復元=オフ（mc26 ウィンドウを展開した後）

-Media Center 26 exe /ショートカットの高 dpi スケーリングを変更>ファイル
のプロパティ>互換性>高DPI 設定の変更（mc26 ウィンドウを展開した
後）
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* reboots if necessary  
 

▼後述でまとめて返信投稿する

*上記の組み合わせ
*必要に応じて再起動します 

 私の返信（９月５日２４時００分にまだ POST してない）▼
  ▼ 有難う B4Unyu さん                                                                                      
▼いくつか試してみた
１．ﾌｫﾙﾀﾞｰｵﾌﾟｼｮﾝのビュー
　→→ｴｸｽﾌﾟﾛｰﾗｰ→ｵﾌﾟｼｮﾝ→ﾌｫﾙﾀﾞｰｵﾌﾟｼｮﾝ→表示タブ→□ログオン時に
以前のﾌｫﾙﾀﾞｰｳｲﾝﾄﾞｳを表示する
 →結果はここにチョンを入れても入れなくても同じだった（MC表示中
有無に関わらず）

２．高 DPI設定の変更
 →MC26のｼｮｰﾄｶｯﾄ上で右ｸﾘｯｸ→互換性タブ→下の「高 DPI設定の変更」
→ ３か所の項目を選択して→                                     
                                                                

 ▲上記のテスト▼
 １．MC26 のショートカットを右クリック→ﾌﾟﾛﾊﾟﾃｨ→互換性→高DPI設定の変更→
                                       
 ▲別ファイル A に記入して試した▲→MC26 が起動できなくなってしまった。▼▼

 ▼途中の困り事の投稿（９月５日２１時４５分に POST した）（その後 Modifi した）

 ▼My reply (problem) (POST at 21:30 on September 5)▼
▼ Thank you B4Unyu and JimH

I'm trying various things, but something went wrong.★
 Right click on the MC26 short cut → Compatibility tab → "Change high DPI★

settings"
After trying this variously,
→ After uninstalling MC26 and reinstalling it,
→ After I click the MC26 shortcut
A small window "Media Center is installed on another OS.Please install Media 
Center again" appears,
→ MC26 cannot be started.

 The same repeats how many times I reinstall the MC26.★
→ Please tell me how to properly reinstall MC26.
(  mysteriously, MC25 works comfortably without any problem)★

 ▼ 私の返信（困り事）（９月５日２１時３０分に POST した）▼
▼ 有難う B4Unyu さん　及び 　JimH さん

  ★色々試している最中ですが、困ったことが起こりました。
★MC26 のｼｮｰﾄｶｯﾄ上で右ｸﾘｯｸ→互換性タブ→「高DPI設定の変更」
これを色々と試した後に、
 →MC26 をアンインストールしてから再インストールした後に、
→私が MC26 のショートカットをｸﾘｯｸした後に
「Media Center is installed on another OS.Please install Media Center again 」
の小窓が出て、
→MC26 が起動出来ません。
★何回私が MC26 を再インストールしても同じ繰り返しです。
→どうすれば MC26 を正常に再インストールできるのですか、教えて下
さい。
（★不思議、MC25 は何の問題もなく快適に動きます）
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 What does this message mean?★
 What is another OS?★

please answer.
I will let you know what I tried and the results next time.★  

★このメッセージは何を意味するのですか？
★他の OS とは何？

 回答をよろしくお願いします。
★私が試した事とその結果は次回にお知らせします。

                                                                                                                                   
  
 ▼自力修復したお知らせ（途中の困り事）の投稿（９月６日１２時頃に POST した）

 ▼ Thank you everyone
▼I'm sorry. I solved it myself.
→ The problem with the above post has been resolved by restoring my 
properties.
→ Right click on MC26 shortcut → Properties →
→Compatibility tab→Chon mark here is all blank→

 Now it's back to its original state.★

▲ However, the mysterious screen problem remains.
→ From now on, I will try various things again.

Thank you for all suggestions
Please continue to give me advice. 

 
 ▼皆さんいつも有難う
▼すみませんでした。自力解決しました。
→前記の投稿の問題は私のプロパティを元に戻したら直りました。
→MC26 のショートカットの右ｸﾘｯｸ→プロパティ→
→互換性タブ→ここのチョンマークを全て空白にした→
★これで元の状態に戻った。

▲しかし、不思議な画面の問題はそのままです。
→これから、また色々試してみます。

皆さん色々な提言を有難う
今後も、私に助言をお願いします。                                

                                                           

 ▼今までにやったこととその結果のまとめて投稿（返信含む）（９月７日１５時３０分に POST した　する予定）

 ▼ Thank you B4Unyu and JimH, everyone.
▼I will let you know what I tried after that and the result.

1. Views of folder options
→ Explorer → View → Folder options → View tab → □ Show previous folder 
window at logon
→ The result was the same whether I put a check here or not. (Whether MC is 
displayed or not)

2. Change high DPI settings
→ Right click on the short cut of MC26 → Compatibility tab → "Change high 
DPI setting" below → I tried by selecting three items, but → It seemed to be 

 ▼ 有難う B4Unyu さん及び JimH さん、皆さん
 ▼その後の試してみたことと、その結果をお知らせします。

１．ﾌｫﾙﾀﾞｰｵﾌﾟｼｮﾝのビュー
　→エクスプローラー→表示→ﾌｫﾙﾀﾞｰｵﾌﾟｼｮﾝ→表示タブ→□ログオン時
に以前のﾌｫﾙﾀﾞｰｳｲﾝﾄﾞｳを表示する
 →結果はここにレ点を入れても入れなくても同じだった。（MC 表示中
有無に関わらず）

２．高DPI設定の変更
 →MC26 のｼｮｰﾄｶｯﾄ上で右ｸﾘｯｸ→互換性タブ→下の「高DPI設定の変
更」→ ３か所の項目を選択して試したが、→一時的に直ったように
なったが、しかし、再起動後には、また元に戻っていた。
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fixed temporarily, but After restarting, it was back again.
▲ However, be careful not to mess with this tab because you will not be able to 
start MC like the above post.

 I fixed it by leaving all the checks in this tab blank★

3. I compared all the tabs of the MC25 and MC26 properties.
→ There were some differences (Owner, MC26 is Administrator, etc.)

→This difference became the same by rebuilding the short cut.
In addition, I tried rebuilding the short cut of MC25, but this MC25 also ★

works comfortably without any problems.
In addition, while doing various things, the MC25 sometimes showed a small ★

screen  at the start.①
 However, this is unstable, and it may or may not come out.★

 Currently, there are two new MC26 and MC25 short cuts in the desktop.★
→When switching between the two, a dialog appears saying "Do you want to 
allow this app to make changes to the device?"

4. I compared in detail whether there is a difference in the option setting of 
MC25 and MC26.
(The MC26 had a few more menus, but it was the same when I tried it)
→The setting contents of both options were the same.
→ It is still unknown why only MC26 is strange.

▲ So far, please let me know if there are anything I should try.
Thank you everyone. I will think further and try various things. 

 ▲しかし、このタブ内を下手にいじると、上の投稿のように MC をス
タートできなくなるので注意。
★私はこのタブ内のチェックを全て空白にして戻したら直った

３．MC25 と MC26 のﾌﾟﾛﾊﾟﾃｨの全部のタブを比較してみた。
→ 一部違いがあった（所有者が MC26 は Administrator 等）

→この違いは、ｼｮｰﾄｶｯﾄを再構築したことにより、同じになった。
★なお、MC25 のｼｮｰﾄｶｯﾄを再構築してみたが、こちらの MC25 も何も問
題なく快適に動く。
★なお、色々やってる内に、MC25 もスタート時に例の小さい画面①が
出る場合もあった。
★しかし、これが不安定で、出たり出なかったりする。

★現在、ﾃﾞｽｸﾄｯﾌﾟに MC26 及び MC25 の新しいｼｮｰﾄｶｯﾄが二つある状態
 →両者を切り替えるときは、「このアプリがﾃﾞﾊﾞｲｽに変更を加えるこ
とを許可しますか？」とダイアログが出るが。

４．MC25 と MC26 のｵﾌﾟｼｮﾝの設定に違いがあるかを詳しく比較してみ
た。
（MC26 はいくつかﾒﾆｭｰが増えていたが、私がそこを試しても同じだっ
た）
→両者のｵﾌﾟｼｮﾝの設定内容は同じだった。
→何故、MC26 だけが変なのか、まだ不明です。
   
▲ここまでですが、このアト、私が試すべき事項があれば、私に教えて
下さい。
有難う皆さん。私は更に考えて色々試してみます。

                                                                                                                                   
 
 ▼JimH さんよりの６回目のリプライと私の返信　2020 年９月８日２２時１０分

 JimH« Reply #26 on: Today at 07:52:46 am »
Try installing an older video driver.  Download it from the manufacturer.  
Uninstall the video software you installed earlier for that video hardware first.  
You only need the driver.  An older driver may work better.  
  

JimH«返信＃26 on：本日 07:52:46 am»
古いビデオドライバをインストールしてみてください。 メーカーから
ダウンロードしてください。 最初に、そのビデオハードウェア用に以
前にインストールしたビデオソフトウェアをアンインストールします。
あなただけのドライバーが必要です。 古いドライバーの方がうまくい
く場合があります。 
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 My reply (Posted at 23:00:00, September 8, 2020)
▼ Thank you Jim H and B4 Unyu

1. The old graphic driver for Windows 10 doesn't seem to be on the internet 
right now.
2. A safe site with a new driver is AMD's site, which B4Unyu also told me in 
Reply #22,
I know from the beginning that it is "https://www.amd.com/en/support/graphics/
radeon-500-series/radeon-rx-500-series/radeon-rx-580".
→ However, old drivers do not appear here.

3. There are no older graphic board manufacturers (ASK).
→ ``https://www.ask-corp.jp/supports/ati_driver.html''
(For some reason, it was before 2017.)

▼ How to find AMD's graphics driver for Windows.
4. I've had a hard time downloading a driver from a bad site before. (The 
"DriverHub" site is the worst)
→ After that, the download only uses safe site.
(There are some sites that check if the site is safe)

5. Even if I search various secure sites with old drivers (for Windows) for 
"AMD RX 580" in Japanese, it doesn't appear.
→ It seems that the release of past versions for Windows has stopped.

6. So, it would be helpful to find a safe site with an old driver in an English 
search. (Official site is better) (because I don't understand English well)
→ My graphic board is exactly "SAPPHIRE-NITRO
RADEON RX 580 8G GDDR5 OC SA-RX580-8GD5N 001V2/11265-01-20G 
[PCIExp 8GB]"

7. In addition, some old drivers remain in my C:AMD folder.
→The following files. (With set-up file)

 radeon-software-adrenalin-2019-19.9.2-minimalsetup-190923_64bit①
 radeon-software-adrenalin-2019-19.10.2-minimalsetup-191024_64bit②
Win10-64Bit-Radeon-Software-Adrenalin-2019-Edition-19.4.1-Apr3③
Win10-64Bit-Radeon-Software-Adrenalin-Edition-18.3.4-March23④
Win10-Radeon-Software-Adrenalin-2020-Edition-20.2.1-Feb3⑤

 私の返信（2020年９月８日２３時０分投稿）                                                     
▼ 有難う JimH さん及びB4Unyu さん
 
１．Windows10 用の古いｸﾞﾗﾌｨｯｸﾄﾞﾗｲﾊﾞｰは今はｲﾝﾀｰﾈｯﾄにない模様です。
２．新しいﾄﾞﾗｲﾊﾞｰのある安全なｻｲﾄは、Reply #22 で B4Unyu さんも教えて
くれた AMD のサイト、
「https://www.amd.com/en/support/graphics/radeon-500-series/radeon-rx
-500-series/radeon-rx-580 」であることは、前から承知しています。
　→しかし、ここでは古いﾄﾞﾗｲﾊﾞｰが出てきません。

３．グラフィックボードの製造元（ASK）にも古いものは出てきません。
→「https://www.ask-corp.jp/supports/ati_driver.html」
 （２０１７年以前のは何故か、有りますが）                                                       

▼ AMD の Windows 用のグラフィックドライバーの探し方について。
４．以前に悪いサイトからﾄﾞﾗｲﾊﾞｰをダウンロードして大変なことになったこ
とがあります。（「DriverHub」のｻｲﾄは最悪）
 →それ以降は、ﾀﾞｳﾝﾛｰﾄﾞは安全なｻｲﾄのみにしています。
（ｻｲﾄが安全かをﾁｪｯｸするｻｲﾄがいくつかあります）

５．日本語で「AMD RX580」用の古いﾄﾞﾗｲﾊﾞｰ（Windows 用）のある安
全なサイトを色々と検索しても出てきません。
→Windows向けの過去バージョンの公開が停止してしまっているようなの
です。 
  
６．そこで、英語の検索で古いﾄﾞﾗｲﾊﾞｰのある安全なサイトを見つけて下さ
ると助かります。（公式ｻｲﾄがベター）（なぜなら私は英語がよく分からな
いので）                                                                                                              
 　→私のグラフィックボードは、正確には「SAPPHIRE-NITRO  
RADEON RX 580 8G GDDR5 OC SA-RX580-8GD5N 001V2/11265-01-2
0G [PCIExp 8GB]」

７．なお、私の C:AMD ﾌｫﾙﾀﾞｰには、いくつか古いドライバーが残っていま
す。
→以下のファイルです。（ｾｯﾄｱｯﾌﾟﾌｧｲﾙがあるもの）
① radeon-software-adrenalin-2019-19.9.2-minimalsetup-190923_64bit
② radeon-software-adrenalin-2019-19.10.2-minimalsetup-191024_64bit
③Win10-64Bit-Radeon-Software-Adrenalin-2019-Edition-19.4.1-Apr3
④Win10-64Bit-Radeon-Software-Adrenalin-Edition-18.3.4-March23
⑤Win10-Radeon-Software-Adrenalin-2020-Edition-20.2.1-Feb3
⑥Win10-Radeon-Software-Adrenalin-2020-Edition-20.4.2-May25
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Win10-Radeon-Software-Adrenalin-2020-Edition-20.4.2-May25⑥
 Among these, re-installable are , , ★ ④ ⑤ ⑥

→ , ,  can not be done because a small window of "Setup has detected an ① ② ③
incompatible build Setup will now exit" appears at the beginning of the 
installation.

→  is the environment up to yesterday,  is the first environment, both of ⑥ ④
which have the problem phenomenon.
→ Today, I re-installed . Currently this environment.⑤

8. The current situation of problems in my environment is still unstable.
→ Currently, I have rebuilt the Shortcut,
MC26 (64bit), MC25 (64bit), MC24 (32bit) are placed on the desktop. (MC20-
MC23 have been deleted. Should have been left.)

9. It is unstable even after rebooting several times.
: A small screen appears in the upper left at the start,①
: When minimized and placed on the task bar, a strange small screen appears ②

when the song changes,
: If the position of the screen is changed on the middle screen, it will return to ③

the original position when the song changes.

→MC26 shows :, :, :. MC24 is comfortable and works smoothly. If you ① ② ③
click MC25, it will be after the screen for administrator confirmation, but it will 
work without problems.
→ However, these are unstable, and the MC 24 and 25 sometimes show a small 
screen of :.①
Immediately after restarting, there are times when  does not appear even with ①
the MC26.

As a result, I think that changing the driver won't fix it? How is it?★
The above is an unstable situation.

 What is the cause of this? .. And how can I fix it?★

 Please let me know if I still have something to try★
Thank you. 

★この中で再ｲﾝｽﾄｰﾙ可能なのは、④、⑤、⑥
→①、②、③は、ｲﾝｽﾄｰﾙの初めに「Setup has detected an incompatible bu
ild Setup will now exit」の小窓が出て、出来ない。

→⑥は昨日までの環境、④は最初の環境で、両方とも問題の現象が出
る。
→本日、⑤を再ｲﾝｽﾄｰﾙした。現在はこの環境。

８．現在のわたしの環境での問題の発生状況は、まだ不安定です。
→現在、私はｼｮｰﾄｶｯﾄを再構築した、
MC26（64bit）、MC25（64bit）、MC24（32bit）がﾃﾞｽｸﾄｯﾌﾟに置いてあ
ります。（MC20～MC23 は削除してしまった。残して置くべきだった。）

９．何回か再起動した後の状態でも不安定です。
 ①：ｽﾀｰﾄ時に左上に小画面出現、
②：最小化してﾀｽｸﾊﾞｰに置いた時に、曲が変わると不思議な小画面出現、
③：中位の画面の時に、画面の位置を変えると曲が変わった場合に元の
位置に戻る。

→MC26 は①：、②：、③：が出る。MC24 は問題なく、快適に動く。M
C25 をｸﾘｯｸすると、管理者確認の画面のあとになるが、問題なく動く。
→しかし、これらは不安定で MC ２４、２５も時々①：の小画面が出る。
再起動直後には MC26 の場合でも①が出ない時もある。

★結果として、私がﾄﾞﾗｲﾊﾞｰを変えても直らないと思われるが？　如何です
か？
以上のような不安定な状況です。
★この原因は何なのか？。そしてどうすれば直るのか？

★まだ私が試すことがあれば私に教えて下さい
有難う。
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▼JimH さんよりの７回目のリプライと私の返信　2020 年９月９日１０時１０分« Reply #28 on: Today at 10:47:10 am » 
JimH« Reply #28 on: Today at 10:47:10 am » 
 If you have another machine, please try to  duplicate the problem on it.

Or a different video card.

 My reply (Posted at 24:30 on September 9, 2020)
▼ Thank you Jim H and tij

1. I tried it on another PC.
→ Install MC26 trial version on another computer (SONY VAIO SVE1713AJ).
(The installation was done by copying and clicking the same set-up file 
(ver26.0.106).)

 When I run MC26 with the trial version (30 days left),★
→ : When I clicked on the short cut, the startup screen appeared in a medium ①
size.
→ : However, if the position of the screen is changed in the middle screen, it ②
will return to the original position when the song changes. (In the same way, 
click the stop button to return to the original position.)
→ : Also, when the song is minimized and placed on the task bar, if the song ③
changes, the middle screen appears without permission. (You won't be left in the
task bar)

▲This phenomenon occurred.
→ It was the same after rebooting.
→ What does this mean? (Why does this happen even though it is another 
computer?)

2. Go back to my desktop computer,
(1) → It was the same even if I changed the mouse.
(The same phenomenon remained with another USB mouse and PS/2 mouse)

(2) → There is no problem with video playback programs other than MC26.
(Microsoft's "Movie & TV", 5K player,)

(3) → I checked the properties of the C: executable file instead of the shortcut, 
but the compatibility mode was blank as well.

 JimH«返信＃28 on：今日の午前 10:47:10»
別のマシンを使用している場合は、そのマシンで問題を再現してみてくださ
い。

または別のビデオカード。 
  
 私の返信（2020 年９月９日２ 4 時 3０分投稿）                     
▼ 有難う JimH さん及び tij さん                                    
 
 １．別の PC で試してみました。
→私の別のパソコン（SONY VAIO SVE1713AJ ）に MC26 試用版をイン
ストール。
（ｲﾝｽﾄｰﾙは、同じｾｯﾄｱｯﾌﾟﾌｧｲﾙ（ver26.0.106）をｺﾋﾟｰしてｸﾘｯｸしてｲﾝｽﾄｰﾙ
した）
★まだ試用版（あと 30 日）の状態で MC26 を私が実行すると、
→①：ｼｮｰﾄｶｯﾄをｸﾘｯｸすると、立ち上がり画面は中位のサイズで出た。
→②：しかし、中位の画面の時に、画面の位置を変えると曲が変わった
場合に元の位置に戻る。（同じように停止ボタンｸﾘｯｸでも元の位置に戻
る。）
→③：また、最小化してﾀｽｸﾊﾞｰに置いた時に、曲が変わると、勝手に中
位の画面が出現する。（ﾀｽｸﾊﾞｰにいるままになってくれない）

▲このような現象が出ました。
→再起動後も同じでした。
→これは何を意味するのか？（別のパソコンなのにどうしてこうなるの
か？）

２．先のの私のデスクトップパソコンに戻って、
（１）→マウスを取り換えても同じでした。
　（別の USB マウス及び PS/2 マウスでも同じ現象のままでした）

（２）→MC ２６以外の動画再生プログラムは問題が出ない。
　（Microsoft の「映画＆テレビ」、５ Kプレイヤー、）

 （３）→ショートカットではなく、C:の実行ファイルのプロパティを
チェックしたが、互換性モードの所は同じく空白でした。

（４）→MC ２６終了時に、「ｃｔｒｌ」＋「MC26 の 」でやると、✖
次回スタート時に前回終了時の画面で出る。というのをやってみたが、
不安定な現象で変わらなかった。
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(4) → When MC26 ends, if you do "ctrl" + "MC26 ", the screen at the end of ✖
the previous time will appear at the next start. I tried to do it, but it did not 
change due to an unstable phenomenon.

▲This is the report of what I did today.
Above 1. Is strange. ? ? ?
Thank you 

▲以上、本日やってみたことの報告でした。
　上の１．の現象が不思議です。？？？
　有難う

                                                                                                                                   
▼tij さんの６回目のリプライと私の返信　2020 年９月９日１０時１６分                                                                  

 tij« Reply #29 on: Today at 12:35:42 pm »
so other MC versions have this problem too?

hmmm ... do you use some tools/utilities that modify Windows behavior?

Do other programs besides MC that behave like this?

Check main executables properties (not shortcuts) to see if compatibility mode 
are enabled on them.

It’s possible the problem can be as simple as your keyboard or mouse not 
working properly (try to use different keyboard and mouse).

If your motherboard/cpu have build in GPU (most do) ... try using that instead of
AMD ... just to see if problem is there too.

 tij«返信＃29 on：本日 12:35:42 pm»
他の MC バージョンにもこの問題がありますか？

うーん... Windows の動作を変更するいくつかのツール/ユーティリティを使
用していますか？

このように動作する MC以外のプログラムはありますか？

ショートカットではなくメインの実行可能ファイルのプロパティをチェックし
て、互換性モードが有効になっているかどうかを確認します。

キーボードやマウスが正しく機能していない（別のキーボードやマウスを
使用してみてください）ほど単純な問題である可能性があります。

マザーボード/ CPU にGPU が組み込まれている場合（ほとんどの場
合）... AMD の代わりにそれを使用してみてください...問題があるかどうか
を確認してください。 
 

▲私の返信は上に混ぜた▲

 
 ▼JimH さんよりの８回目のリプライと私の返信　2020 年９月１０日１１時１０分 

« Reply #31 on: Today at 02:09:11 pm » 
 What is the full version of MC26?  26.0.107 is available.

The fact that other programs work does not eliminate the video driver as the 
cause.   That's just how bugs work.
 

 MC26のフルバージョンは何ですか？ 26.0.107が利用可能です。

他のプログラムが機能するという事実は、原因としてビデオドライバを
排除しません。 これがバグのしくみです。 
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 My reply (Posted at 11:30 on September 10, 2020)
▼ Thank you Jim H
1. The MC26 ver on another my PC is currently 26.0.107.
→ It seems that the second import was automatically performed immediately 
after the installation, and it became "26.0.107".
→ Yesterday's phenomenon report is about this environment.
→ If the same phenomenon occurs even though the video driver etc. is in a 
completely different environment, it seems that there is a bug on the MC26 side.

 Please check if this phenomenon occurs on other people's PCs.★
→ : When I clicked on the short cut, the startup screen appeared in a medium ①
size.
→ : However, if the position of the screen is changed in the middle screen, it ②
will return to the original position when the song changes. (In the same way, 
click the stop button to return to the original position.)
→ : Also, when the screen is minimized and placed on the taskbar, if the song ③
changes, the middle screen will appear without permission. (You won't be left in
the task bar)
 (The story when you click the "-" button on the upper right) 

2. Just in case, I will replace it with another video card and check what happens.

That's all for now. Thank you. 

                                                                

 私の返信（2020 年９月１０日１１時３０分投稿）                   
▼ 有難う JimH さん  
１．別の私の PC での MC26 の ver は、現在 26.0.107 です。
→ｲﾝｽﾄｰﾙ時点で直ぐに２回目の取り込みが自動的に行われて、
「26.0.107」になった模様です。
→昨日の現象報告はこの環境での話です。
→ﾋﾞﾃﾞｵﾄﾞﾗｲﾊﾞｰ等が全く別の環境なのに、同じような現象が出るという
ことは、もはや、MC26 側にバグがあるとしか思えません。

★他の皆さんの PC でも、この現象が出るかをﾁｪｯｸして下さい。
→①：ｼｮｰﾄｶｯﾄをｸﾘｯｸすると、立ち上がり画面は中位のサイズで出た。
→②：しかし、中位の画面の時に、画面の位置を変えると曲が変わった
場合に元の位置に戻る。（同じように停止ボタンｸﾘｯｸでも元の位置に戻
る。）
→③：また、画面を最小化してﾀｽｸﾊﾞｰに置いた時に、曲が変わると、勝
手に中位の画面が出現する。（ﾀｽｸﾊﾞｰにいるままになってくれない）
 （右上の「ー」ボタンをｸﾘｯｸした時の話）

２．このアト、念のために、別なビデオカードに入れ替えて、どうなる
かﾁｪｯｸしてみる予定です。

とりあえず以上です。有難う。

                                                                                                                                   
 ▼ RoderickGI（MC Beta Team ）　さんからの初めてのリプライと私の返信　2020 年９月１０日１６時００分                                 

RoderickGI« Reply #33 on: Yesterday at 10:26:59 pm »

Last time I saw a report like this that didn't respond to changing the Windows 
DPI settings, or font sizing in MC, and other issues discussed, the problem was 
caused by the Language MC was set to use. I believe high DPI screens were 
handled slightly differently in Asian languages, either in Windows or MC, I'm 
not sure. It could have actually been the language that Windows was set to. It 
certainly was a combination of Language and other settings. It may have been 
fixed with a video driver update.

Sorry I can't remember more detail. There is probably a thread on the forum 

 RoderickGI«返信＃33 on：昨日の午後 10時 26分 59秒»

Windows DPI 設定の変更、または MC のフォントサイズ変更に応答しない
このようなレポートを前回見たとき、およびその他の問題については、MC
が使用するように設定されていることが原因でした。高DPI 画面は、アジ
ア言語では Windows または MC のどちらかで少し異なって処理されたと思
いますが、よくわかりません。それは、実際には Windows が設定されて
いる言語であった可能性があります。言語と他の設定の組み合わせでし
た。ビデオドライバの更新で修正された可能性があります。

詳細を思い出せません。おそらくフォーラムのどこかにスレッドがありま
す。 
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about it somewhere.
 

 ★RoderickGI（MC Beta Team）の下部線の下部★
What specific version of MC you are running:MC27.0.11 @ Sept 9, 2020 and 
updating regularly Jim!                        MC Release Notes: 
https://wiki.jriver.com/index.php/Release_Notes
What OS(s) and Version you are running:     Windows 10 Pro 64bit Version 1903
(OS Build 18362.720).
The JRMark score of the PC with an issue:    JRMark (version 26.0.52 64 bit): 
3419
Important relevant info about your environment:     
  Using the HTPC as a MC Server & a Workstation as a MC Client plus some 
DLNA clients.
  Running JRiver for Android, JRemote2, Gizmo, & MO 4Media on a Sony 
Xperia XZ Premium Android 9.
  Playing video out to a Sony 65" TV connected via HDMI, playing digital 
audio out via motherboard sound card, PCIe TV tuner

                                                                
 ★RoderickGI（MC Beta Team）の下部線の下部★

実行している MC の特定のバージョン：MC27.0.11 @ 2020 年 9 月 9 日、Jim を

定期的に更新！ MC リリースノート：https://wiki.jriver.com/index.php/Release_
Notes
実行している OS とバージョン：Windows 10 Pro 64 ビットバージョン 1903（O
S ビルド 18362.720）。

問題のある PC の JRMark スコア：JRMark（バージョン 26.0.52 64 ビット）：3
419
環境に関する重要な関連情報：
HTPC を MC サーバーとして、ワークステーションを MC クライアントといくつ

かの DLNA クライアントとして使用します。

Sony Xperia XZ Premium Android 9 で Android、JRemote2、Gizmo、MO 4M
edia 用の JRiver を実行する。

HDMI 経由で接続された Sony 65 インチ TV へのビデオ出力、マザーボードサウ

ンドカード、PCIe TV チューナー経由でのデジタルオーディオ出力 

                                                                                                                                   
  ▼ tij（MC Beta Team ）　さんからの７回目のリプライと私の返信　2020 年９月１０日１６時００分 

 tij« Reply #34 on: Today at 12:01:37 am » 
  上部にあるの囲み線内の記事
Quote from: RoderickGI on   Yesterday   at 10:26:59 pm   
 Last time I saw a report like this that didn't respond to changing the Windows 
DPI settings, or font sizing in MC, and other issues discussed, the problem was 
caused by the Language MC was set to use. I believe high DPI screens were 
handled slightly differently in Asian languages, either in Windows or MC, I'm 
not sure. It could have actually been the language that Windows was set to. It 
certainly was a combination of Language and other settings. It may have been 
fixed with a video driver update.

Sorry I can't remember more detail. There is probably a thread on the forum 
about it somewhere. 
 ーーー以下本文ーーーーーーーーーーーーーーーーーー
Looks like you using some skin for MC ... try changing skin to default to see if 
problem persist. If problem gone then it’s the skin that has problem.

If problem persist, then try standard skin with English user interface to see if it’s

  ▼▼tij«返信＃34 on：本日 12:01:37 am»
上部にあるの囲み線内の記事
★引用元：RoderickGI、昨日の午後 10時 26分 59秒
Windows DPI 設定の変更、または MC のフォントサイズ変更に応答しない
このようなレポートを前回見たとき、および他の問題が議論されたが、問
題は言語 MC が使用するように設定されていたことが原因でした。高DPI
画面の処理は、アジア言語では Windows と MC のどちらかで少し異なると
思いますが、よくわかりません。実際には、Windows が設定されている言
語でした。それは確かに言語と他の設定の組み合わせでした。ビデオドラ
イバの更新で修正された可能性があります。

詳細を思い出せません。おそらくフォーラムのどこかにスレッドがありま
す。
ーーー以下本文ーーーーーーーーーーーーーーーーーー
MC にスキンを使用しているようです...スキンをデフォルトに変更して、問題
が解決するかどうか確認してください。問題がなくなった場合、問題があ
るのはスキンです。

問題が解決しない場合は、英語のユーザーインターフェイスで標準のスキ
ンを試して、問題の原因が日本語のユーザーインターフェイスかどうかを
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Japanese User Interface that’s causing the problem.

ーーーーーーーーーーーーーーーーーーーーー
★tij（MC Beta Team）の下部線の下部★
HTPC: Win10: v1909 (18363.657), MC: v26.0.22 (64b), NV Driver: v425.31, 
CPU: i7-6700, MB: Gigabit H170-HD3, 32GB RAM, GeForce: Gigabit 1070, 
240GB SSD
Screen: LG 2016 E6
NAS: FreeNAS 11.1, SuperMicro SSG-5048R-E1CR36L, E5-1620v4, 64GB 
ECC RAM, 6xHe12-SAS3 drives, 2x240GB SSD (OS)

――――――――――――――――――――――――――――――
My reply (Posted at 24:40 on September 10, 2020?)
▼ Thank you tij and RoderickGI

 I tried changing the skin by changing the language state, but it didn't work.★
1: I changed all the skins on MC26 in Japanese and tried them one by one, but 
the problem was not fixed.
→ A small screen appears in the upper left when starting. etc

2: I tried the language status in English, but the problem was not fixed.
→ However, at the time of start, the middle screen often appears around the 
center.
(There was also a skin with a small screen on the upper left.)
(When I tried the same thing before, there were many cases where a small 
screen appeared?)
→ After moving the position of the middle screen, it will return to the original 
position when moving another video.

3: The same result was obtained in Spanish.
 It seems that the cause is neither language nor skin.★

(However, the appearance of the phenomenon is unstable.)
 Also, I tried it before,★

→ If the next song is a sound-only file, the song will start without returning to 
the screen. → («Reply # 13 on: September 03, 2020, 06:49:02 am»)

▼ In addition, RoderickGI's reply says that there may be a problem only in the 
environment where the language is Japanese, so check "Media Center in 
Japanese" to see if other Japanese have the same phenomenon. I would like to 

確認してください。

ーーーーーーーーーーーーーーーーーーーーー
★tij（MC Beta Team）の下部線の下部★
HTPC：Win10：v1909（18363.657）、MC：v26.0.22（64b）、NVドライ
バー：v425.31、CPU：i7-6700、MB：ギガビット H170-HD3、32GB RA

M、GeForce：ギガビット 1070、240GB SSD
画面：LG 2016 E6
NAS：FreeNAS 11.1、SuperMicro SSG-5048R-E1CR36L、E5-1620v4、6
4GB ECC RAM、6xHe12-SAS3 ドライブ、2x240GB SSD（OS）  
 
 ーーーーーーーーーーーーーーーーーーーーーーーーーーー
私の返信（2020 年９月１０日２４時４０分？投稿）                  
▼ 有難う tij さん 及び RoderickGI さん

  ★言語状態を変えてｽｷﾝを変えてみましたが、ダメでした。
１：日本語状態で MC26 にある全部のｽｷﾝを変えて一つひとつ試してみ
ましたが、問題は直りませんでした。
　→どれもｽﾀｰﾄ時には左上に小画面が出る。等

２：言語状態を英語で、試しましたが、問題は直りませんでした。
　→ただし、ｽﾀｰﾄ時には中位の画面が中央あたりに出る場合が多い。
　（左上に小画面が出るｽｷﾝもありました。）
　（以前同じことを試した時は、小画面が出る場合が多かったが？）
　→中位の画面の位置を移動させた後の、別動画移動時は元の位置に
戻ってしまう。

３：スペイン語でも同じ結果でした。
★原因は、どうやら、言語でも、ｽｷﾝでもないと思われます。
 （しかし、現象の出方は不安定です。）
★また、以前に試しましたが、
→次の曲が音だけのファイルの時は、画面が戻らないでそのまま曲が始
まります。→（« Reply #13 on: September 03, 2020, 06:49:02 am » ）

▼また、RoderickGI さんのﾘﾌﾟﾗｲでは、言語が日本語の環境だけの問題
が有るかも知れない、とのことなので、他の日本人に同じような現象が
あるかを、「Media Center in Japanese」に投稿してみたいと思います。
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post. 

                                                                                                                            
                                                                                                                                   
 ◆◆choropapa さん等へのお願い　を日本語ﾌｫｰﾗﾑへ出す。2020 年 9月 10 日２４時 15 分
                                                                                                                                   

                                                                

                                                                

                                                                

★ choropapa さんほか、日本の皆さんへ　のお願いです。

▼１か月ほど前に、このトピック（MC27  　先行予約をしました  ）の中で、
（« Reply #6 on: August 07, 2020, 04:21:08 am » ）以降で、MC26 のスター
ト時とその後の画面がおかしい。という投稿をしましたが、未解決のま
までした。
→その後、自分で英語のﾌｫｰﾗﾑ（INTERACT FORUM > Windows > JRiver 
Media Center 26 for Windows ）の中に投稿をして、解決策を見つけても
らうように、英語で（ｸﾞｰｸﾞﾙ翻訳で）色々とやりとりをしてきました。

→詳しくは、「https://yabb.jriver.com/interact/index.php/
topic,126683.0.html?PHPSESSID=tals6p0hcl78q8p3obrl5e8ns4」を見て下さ

い。

→JimH さんや色々な方がリプライを何回もしてくれています。
★本日、（RoderickGI さんのﾘﾌﾟﾗｲで）原因の一つの可能性とし
て、MC26 の日本語の環境の中だけに何かがあるかも知れない、と分
かってきたので、日本語の MC26 を使っている皆さんの環境で以下のよ
うな同じ現象が出るかを確認して頂きたい。
　というお願いです。

▼ﾁｪｯｸして欲しいのは、
１．皆さんのパソコンでは、次のような現象がないか。
→①：MC26 のｼｮｰﾄｶｯﾄをｸﾘｯｸすると、立ち上がり画面が左上に変な小画
面で出る。
→②：MC26演奏中に、中位の画面の時に、画面の位置や大きさを変え
ると曲が変わった場合に元の位置に戻る。（同じように停止ボタンｸﾘｯｸ
でも元の位置に戻る。）（なお、次の曲が音だけのﾌｧｲﾙだと戻らない。
動画だと戻る。？）
→③：また、画面を最小化してﾀｽｸﾊﾞｰに置いた時に、次の曲に変わる
と、勝手に中位の画面（又は変な小画面）が出現する。（ﾀｽｸﾊﾞｰにいる
ままになってくれない）
 （右上の「ー」ボタンをｸﾘｯｸした時の話）
 
２．もしお持ちの別の PC で、MC26 の試用版をｲﾝｽﾄｰﾙしたら、これら
の現象が出ないか？。（ver は、現在 26.0.107 です）
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https://yabb.jriver.com/interact/index.php?PHPSESSID=tals6p0hcl78q8p3obrl5e8ns4&#c2
https://yabb.jriver.com/interact/index.php?PHPSESSID=tals6p0hcl78q8p3obrl5e8ns4&
https://yabb.jriver.com/interact/index.php/topic,126133.msg877424.html#msg877424


（ﾀﾞｳﾝﾛｰﾄﾞｻｲﾄ→「https://jriver.com/download.html」）
→私の別のﾉｰﾄﾊﾟｿｺﾝ（SONY VAIO SVE1713AJ）では、おかしな現象が
出たのです。（「あと 30 日」の状態のままで）
（全然違う環境なのにどうして現象が出るのかが不思議なので）

★これらの現象がもし出れば、問題は私のパソコン環境だけのせいでは
ない。他の日本人のにも出てますよ。と言えるので、よろしく。

◆なお、英語のﾌｫｰﾗﾑを見ても、英語では分からないという方のため
に、私の「ｸﾞｰｸﾞﾙ翻訳日英対比表」の PDF ﾌｧｲﾙを添付しましたので、参
考にして下さい。
 
★以上、すみませんがよろしくご協力お願いします。                
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